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111...   IIInnntttrrroooddduuuccctttiiiooonnn   

1.1. What is the MPEG-4 Video Server? 
The MPEG-4 Video Server (15-CD01NB) is an Internet-based digital video 
surveillance device with a built-in Web server. It uses TCP/IP to distribute 
compressed live video over a Local Area Network (LAN) and/or the Internet through 
an Ethernet connection. 

The 15-CD01NB is configured and manipulated using the Web-based User 
Interface  

(Web UI) in Microsoft Internet Explorer ™. 

The 15-CD01NB contains an MPEG-4 image compression chipset capable of 
delivering streaming, constant or variable bit rate MPEG-4 video over the network 
in real-time.   

1.2. Advanced Features 
� Built-in HTTP Web Server. 

� IP address assignment via IP Installer Software or Web UI. 

� ActiveX control for Microsoft Internet Explorer ™ providing maximum 
performance. 

� Provide Video conference function. 

� Provide recording functions on remote host or storage devices. 

� Support some models of PTZ control protocols. 

� DDNS support for dynamic IP application. 

� Multi-tiered access control. 

� Control of server operations through CGI based scripts for easy integration. 

� Provide Motion detection, E-Mail / FTP settings and Alert for management.  

� Low power, fan-less device with hardware watchdog support providing a robust 
system for critical environments. 

� MPEG-4 and MJPEG video compression formats. 

� 30/25 fps @ Full D1 (720 x 480 / 720 x 576) resolution. 

� Video stream supported by many media players including QuickTime ™. 
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222...   PPPhhhyyysssiiicccaaalll   CCChhhaaarrraaacccttteeerrriiissstttiiicccsss   
 

MPEG-4 Video Server  
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333...   IIInnnssstttaaallllllaaatttiiiooonnn   

3.1. Installation Preview 
There are 3 mains steps required to perform a successful installation: 

� Hardware installation 

� Software installation 

� Network configuration 

 

Hardware installation consists of connecting cables to the 15-CD01NB including 
network, video, and power cables. 

Software installation consists of the installation of software that is necessary to 
properly view the video from the 15-CD01NB or to configure the 15-CD01NB itself.  

The software includes: 

� IP Installer - A utility for locating devices and configuring network settings on a 
LAN. 

� Component Installer - installs all ActiveX components used by devices for 
things such as video display and configuration. 

� Adobe Flash Player - necessary for displaying some components of the Web 
UI. 

 

The following are not necessary, but may be used for added convenience: 

� 16-Channel Recording Software - for displaying and recording up to 16 
channels simultaneously. Both MPEG-4 and MJPEG devices are supported. 

Note: the MPEG-4 device can only display and record up to 4 channels. 
� XVID - A MPEG-4 codec. If no other MPEG-4 codecs (i.e. DivX, 3ivX, ffdshow, 

etc.) are installed on your computer, the Component installer will install this for 
you. 

� QuickTime or VLC - though not necessary, this can be used for viewing the 
MPEG-4 stream without a Web browser. 

 

Network configuration consists of modifying the network settings for the 
15-CD01NB in order to successfully connect to the device. 
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3.2. Hardware Installation 
– Hardware Connection 
� Ensure the 15-CD01NB is powered off.  

� Connect the 15-CD01NB to your network using twisted pair (CAT 5) cable 
terminated with a standard RJ-45 connector.  

If it is connected to a hub/switch, use a pass-through cable.  

If it is connected directly to a PC, use a crossover cable.  

� Connect the video output from the camera using standard 75 ohm (Ω) coaxial 
cable terminated with a BNC connector. (If connecting to a TV, VCR, etc. switch 
the corresponding DIP Switch to the off position. 

� After ensuring that the power supply adapter specifications (Input AC 110V or 
220V ) match the power source, connect the power supply to the 15-CD01NB. 
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– Description of the Connections 

 

J1: Connector for Power / Sensor / RS-485 

AC24V: power input 24V 

ALM 1~ALM4: sensor input 

COM1~COM4: sensor common 

RS-485+: to RS-485 + 

RS-485-: to RS-485 - 

 
 

 

J2: RS-485 Terminal   

 

J8: AC24V Output 

 

J3: Alarm Output / Input 

  NC / CM / NO: Alarm output 

  ALM1~ALM4 / COM: Alarm Input 

 

J4: Alarm Output   

  NC / CM / NO 

Ethernet Connector 
Standard 10 /100 Base-T port connects to a CAT5 cable with RJ-45 connector. 
Please follow the below figure for the connection. 

 
 

 

3. Power/Status LED 
Power status indicator, constant red when power is on. 
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4. Network LED 

z Network Link (connected): Constant red.  

z Networks have activities: Blink red. 

z Data sent out from server: Blink green. 

z Network disconnected: Constant slow blinking green. 
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3.3.  Software Installation 
With the exception of the Adobe Flash Player all the software that is necessary for 
the proper display and use of the 15-CD01NB is available on the included CD or 
from the Web site. For the following installation procedures it is assumed that all 
installation media will be taken from the CD.  

 

– IP Installer 
The IP Installer is used to locate and configure network cameras and video servers 
on the LAN. This utility is useful for conveniently configuring the network settings of 
the 15-CD01NB, or for finding a device once the network settings have been 
modified.  

To install the IP Installer, from the installation CD UI, select IP Installer, then follow 
the on screen instructions. 

 

– Component Installer 
This will install all ActiveX components used by devices for video display and 
device configuration.  

 

– Adobe Flash Player 
Please visit the Adobe Web site at http://www.adobe.com to download and install 
the Flash Player.  
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3.4. Network Configuration 
IP Installer is a utility that provides an easier, more efficient way to configure the IP 
address and network settings of the 15-CD01NB. It even provides a convenient 
way to set the network settings for multiple devices simultaneously using the batch 
setting function. Moreover, IP Installer can save the network settings for all devices 
as a backup and restore them when necessary.  

 

– Preparation before IP Assignment 
� Always consult your network administrator before assigning an IP address to 

your server in order to avoid using a previously assigned IP address  

� Ensure the 15-CD01NB is powered on and correctly connected to the network 

� MAC Address: Each 15-CD01NB has a unique Ethernet address (MAC address) 
shown on the bottom of the 15-CD01NB as the serial number (S/N) with 12 
digits (e.g. 000429-XXXXXX). 

 

� One final note, although the IP Installer is able to find and configure any 
15-CD01NB on the LAN (except those that are behind a router), it is a good 
idea to set the host PC to the same subnet. In order to connect to the Web UI of 
the 15-CD01NB the host PC must be in the same subnet. For more information 
about subnets, please consult your network administrator. 

 

– Starting IP Installer 
� Once IP Installer has been successfully installed on the computer, double click 

the IP Installer icon on the desktop, or select it from Start > Programs > IP 
Installer. 
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� The IP Installer window is displayed below. Click Tool > Search Network Device, 
the available devices will be listed as below. 

 
 

� Using IP Installer 

 
1. From the list, select the device with the MAC Address that corresponds to 

the device that is to be configured. The MAC Address is identical to the 
unit’s S/N (Serial Number). 

2. Double click the item to open the Property Page dialog box for the selected 
device or click the menu bar View > Property. 
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3. After filling in the properties, click [Synchronize] button to complete the 

configuration settings and save in the network camera and PC immediately. 
4. If click [OK] button, the configuration is only be saved in the PC. 

 

� Opening the Web UI 

To access the Web UI of the selected unit, right-click on an item in the list and 
select Open Web, or click View > Open Web on the menu bar. 

If the device has been configured correctly, the default Web browser will open 
to the 15-CD01NB home page of the selected device. 
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If the QuickTime Player has been properly installed, and the video input has been 
properly connected, then the 15-CD01NB Web UI will display a live video stream. 

 

 

The 15-CD01NB supports video display using either QuickTime (default) or 
ActiveX. The ActiveX control is only supported in Microsoft Internet Explorer for 
Windows operating systems.  
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If the device has been configured to display the video using the ActiveX control, 
when the Web UI opens for the first time through Internet Explorer, the Internet 
Security settings must be lowered to perform a one-time-only installation of the 
ActiveX component.  

 

– The procedure of the ActiveX is as follows 
� Before connecting to the 15-CD01NB Web UI, from the Tools menu, select 

Internet Options. 

� Click the Security tab and take note of your current security settings. 

� Set the security level to Low and click OK. 

� Type the URL or IP address of the 15-CD01NB into the Address field. 

� A dialog box will pop up asking if the ActiveX control should be installed. 

� Click “Yes” to start the installation. 

� Once the ActiveX installation is complete, return the security settings to their 
original value, as noted above. 
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444...   GGGeeettttttiiinnnggg   tttooo   KKKnnnooowww   ttthhheee   111555---CCCDDD000111NNNBBB   WWWEEEBBB   UUUIII   
The 15-CD01NB Web UI is basically divided into display and configuration. The 
home page is the video display page which can be seen below.  

 

– Main Menu 
� Menu Language Selection 

Click a language name to change the language display for the complete Web UI. 

There are three kinds of languages can be selected, they are English, Traditional 
Chinese and Simplified Chinese.  

� Video Channel 

Displays either a single video source (from 1 to 4), or all 4 channels 

Select “Actual” to display the video stream at the real resolution 

Select “All” to display the local video stream as well as 3 external video sources. 
It is only available for the video server. 
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� Video Status  

Display the status for the selected channel on       

the tab:  Video IP, RTSP Port, Resolution,     

PTZ, Video Type (Mpeg4 or Mjpeg) and Audio. 

 

 

z Audio  

☆ Audio ON 

Voice is currently ON; select which channel should be the one for 
broadcasting the audio. 

☆ Audio OFF 

Voice is currently OFF, click on the icon to turn off the voice feature. 

 

z Record Button 
Start Recording / Stop Recording 

Click on the “Record” button to start or stop recording. 

Note: This option saves a video streaming into the local computer as an AVI file, 
and it will be named under Locals_Rec_-YYYYMMDD-HHMMSS.avi. 

For “YYYYMMDD” stand for year, month and date respectively 

For “HHMMSS” stand for hour, minutes, seconds respectively. 

The path to save the recorded files is listed under Recording Setting.  

The device will create the folder automatically. 
 

z Rotation Button 
Turn the image for 90, 180 and 270 degrees. It’s clockwise direction. 

 

� Configuration  

Click Configuration to open the configuration pages. 

This part of detailed contents will be introduced in the “Ch5 15-CD01NB 
Configuration”. 
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� Video Conference  

Click “Configuration” to open the configuration pages. 

z Location 
Define the settings for the local device. 

z Remote 
Define the settings for the remote device, either IP Camera or Video Server. 
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z Record Setting Video Conference 

 

☆ Reserve Space: 

Set the total file space for the recording. The unit is in MB. 

☆ Max File Length: 

Set the file space that a single will be using. The unit is in MB. 

☆ Save File Path: 

Indicate which folder should be the file saved to. 

☆ Local File Name: 

Input the name for the local file. 

☆ Remote File Name: 

Input the name for the remote file. 

☆ Cycle Recording: 

This feature indicates if the old space should be used or not for the 
recording. Make a checkmark in order to enable this function. If you enable 
this feature, old files will be deleted. 

☆ Sync to TimeStamp: 

This feature enables the file to be saved according to the time. When the 
video file is displayed, the video will make a match between the frames and 
the time.  
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z Record Setting Video Conference 

 

☆ IP Address: 

Enter a valid IP address from a remote IP Camera or Video Server. 

☆ HTTP Port: 

Enter the port number used for the remote IP address to display the video. 

☆ User Name / Password: 

Enter the respective Username and Password if applicable. If no user has 
been set for the device, the default value should be “root” and “pass” 
respectively. 

☆ Video Channel 1~4: 

Video channels from 2 to 4 are applicable for Video Servers 

☆ Video Type: 

Select from MJPEG or MPEG4 Video Servers or IP Cameras.  

Please refer to the original document of the device for a better description. 

☆ Rotation: 

Rotation degrees run from 0 to 270 degrees for a permanent digital 
position. 

☆ RTSP Port: 

Enter a RTSP Port used for streaming in case the external source is an 
MPEG4 device. 
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☆ Name: 

Enter a name for the remote device. 

☆ PTZ Model: 

Support some kinds of PTZ models to control remote devices. 

Note: If your PTZ devices don’t support these models on the menu list, 
please contact with your distributor. 

☆ Product Type: 

Select from MJPEG or MPEG4 Video Servers or IP Cameras. Please refer 
to the original document of the device for a better description. 

 

�  

� Recording Setting  

Click Recording Setting to open the    

configuration pages. 

 

 

 

z Location of Recorded Files:  
     Indicates the folder path in which the files will be recorded. 

z Local Source file name:  
Enter a name for the recorded video 

z External Source File Name:  
Enter a different name from the local source file name. 

 

� Full Screen  

Maximizes to view the selected channels into full screen 
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555...   111555---CCCDDD000111NNNBBB   CCCooonnnfffiiiggguuurrraaatttiiiooonnn   
The 15-CD01NB Configuration is currently divided into 4 sections, “Live” and 
“Reboot”: 

 

 
– A/V Settings  

Set A/V settings and they include “General”, “PTZ Setting”, “External Source” 
and “On Screen Display”. 

– Network Settings   
Set the network settings and they include “General”, ” and ”DDNS”.  

– System  
Set the system settings and they include “System Information”, “Time 
Configuration” and “Users”. 

– Event  
Set the event setting and they include “General”, “Motion Area” and  

“E-Mail / FTP”. 

– “Live” : Returns to the Live Video display. 
– “Reboot”:: Closes the Web browser window and reboots the device. 
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5.1. A/V Settings 
– General  
 

Basic: 

 

� Audio 

Enables and Disables the Audio stream. 

� Resolution  

There are 3 different resolutions to choose from: 

☆ D1: 720x480 NTSC/720x576 PAL 

☆ SIF: 352x240 NTSC/352x288 PAL 

☆ QSIF: 176x112 NTSC/176x144 PAL 

� Frame Rate  

The frame rate can be set between 1-30fps. 

� Encoder Format  

Format can be selected for MPEG4 or MJPEG. 

� Bitrate  

There are 12 different constant bitrates to choose from between 64Kbps and 
4Mbps, and 4 variable bitrates between Low and High quality. 
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If you are planning on using the device on an Internet connection It is 
recommended that you select a constant bitrate that corresponds to your actual 
upload speed. It is also recommended that you modify the frame rate and 
resolution as well, otherwise the video stream may become blocky or otherwise 
distorted.  

The recommended values are as follows:  

64Kbps: <=10 fps QSIF  

128Kbps: <=15 fps QSIF  

256Kbps: <=10 fps SIF 

512Kbps: <=15 fps SIF  

768Kbps: <=10 fps D1  

1Mbps: <=15 fps D1  

1.5Mbps: Broadband-cable, T1, Frame-Relay  

2Mbps: Cable, T1, Frame-Relay, 10Mbit  

2.5Mbps: Cable, T1, Frame-Relay, 10Mbit  

3Mbps: Cable, T1, Frame-Relay, 10Mbit  

3.5Mbps: Cable, T1, Frame-Relay, 10Mbit  

4Mbps: 10/100Mbit  

For higher frame rate use a variable bitrate instead. However, this is not 
recommended for Internet use.  

For Good Quality, full resolution (D1), and full frame rate (30/25 fps) it is 
recommended that not more than 4 users connect simultaneously.  

For High Quality, full resolution (D1), and full frame rate (30/25 fps) it is 
recommended that not more than 2 users connect simultaneously. 

 

� Auto adjust the frame rate under high-traffic icon:  

After enable this option, the frame rate will be automatic adjusted to improve 
the video quality when the network is heavy-loaded. 

Note: Turn off audio will improve the video quality. 

 

� Apply  

Saves the changes made.  
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Advanced: 

 

� Interlacing  

There are two modes available: Interlaced or Progressive. 

Interlaced mode is a storage mode. An interlaced video stream contains fields 
rather than frames, with each field containing half of the lines of a frame. 

A progressive video stream consists of only full frames. 

Interlaced video streams can bring a lower bitrate but may cause lower quality. 

� TV Standard  

This is the manual setting; users have to select the TV standard mode of NTSC 
or PAL. 

Note: If you do the factory default procedure, the TV standard setting will go 
back to NTSC mode. 

� Sequence Mode  

There are 2 different modes available: I-frames only or I-frames and P-frames. 

P-frames, or predictive frames, are predicted based on prior P or I-frames plus 
some additional data. They have a much higher compression ratio than 
I-frames. 

☆ I-frame only mode has very little compression resulting in large file sizes. 

☆ I-frame and P-frame mode offers relatively good compression with medium 
file sizes. Although this requires more work on the host PC to decode the 
video. 
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� GOP Size  

GOP stands for Group of Pictures. It defines the number of frames from one 
I-frame to the next. Since an I-frame uses very little compression, while P/B 
frames use much higher compression, a larger GOP size, results in smaller file 
sizes. For more information about I/P/B-frames, see below. 

For MPEG-4 there is no maximum GOP size defined. It can be as low as 1 V 
just an I-frame - or into the thousands. However, as the GOP size increases, 
the compression increases, and therefore the more likelihood of errors. A 
higher GOP size also results in higher buffering times. 

For DVDs the GOP size is 15. The default on the 15-CD01NB is set to 60, 
which offers fair compression with a low likelihood of errors. 

� Peak Bitrate  

This is used to set a maximum bitrate that can be achieved. This is useful for 
setting bitrates between the values that are available from the Video Encoder 
bitrate list. 

� Apply  

Saves the changes made. 
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Image Adjustment: 

 

� Contrast, Brightness, Hue and Saturation can be adjusted. 

Values run from -100 through 100. 

� Rotation 

Select the Digital Rotation for the camera: 0 – 0 or 360 Degrees; 1- 90 Degrees; 
2- 180 Degrees; 3- 270 Degrees. 

� Save  

Save the update settings. 

� Load Default  

Set the image adjustments back to factory default. 

 

Note for MPEG-4 IP camera: When using Lens with DC-Driver Auto IRIS 
capabilities in low light conditions, you should disable AES to get optimal lens 
performance. In strong light conditions it should be enabled to prevent color loss. 
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– PTZ Settings  
 

 
� PTZ Model:  

Support some kinds of PTZ models to control remote devices. 

Note: If your PTZ devices don’t support these models on the menu list, please 
contact with your distributor. 

� Camera ID:  

Define camera ID to connect video servers when using multi PTZ devices.  

� Serial Mode:  

Select the serial mode to RS232 or RS485. 

� COM port:  

This the read-only information and it will auto detect the COM port. 

� Serial databits, Serial baud rate, Serial stopbits and Serial Parity:  

Every PTZ device has independent PTZ control protocol; please refer the PTZ 
product manual to check these settings. 
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– External Sources  
 

 
 
The “External Sources” feature allows user to set additional network cameras for 
the device.  

� Video select:  

15-CD01NB support four sources to do video control and monitor; the first one 
is internal source for analog camera connection, so the “Video select” is from 2 
to 4. 

z IP Address:  
     Enter a valid IP address from an IP Camera or Video Server. 

z Video Channel:  
     Assign the number of the video channel to identify the video source when use 

     multi channels management software.  

z HTTP Port:  
     Enter the port number used for the IP address to display the video. 

z User Name & Password:  
     Enter the user name and password of the device, if no user has been set for     

     the device, the default value should be “root” and “pass” respectively. 

z Video Type:  
            Select the MJPEG or MPEG4 mode. 

z Rotation:  
     Rotation degrees run from 0 to 270 degrees for a permanent digital position. 
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z PTZ Model:  
            Select the PTZ model if it is an IP speed dome. 

z Name:  
            Enter the name for the device. 

z RTSP Port:  
            Enter the port for the streaming. 

z Product Type:  
            Select the product type. 
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– On Screen Display 
 

 
  Display a text on top of the video 

  1. Select “0: Disable” or “1: Enable” on screen display item. 

  2. Enter into the OSD text that should be displayed. 

  3. Select Coordinates X, Y for the location of the text. 

  4. Enter the Display Font Gray Levels. 
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5.2. Network Settings  
– General 

 

 
� Please select the appropriate option to connect.  

z MAC Address: It’s read-only to displays the MAC address of the device. 

z IP Address: Enter the IP address of the device. 

z Subnet Mask: The subnet mask for the network segment to which the device 
is connected.  

z Device Name: Input a name for the device. 

z Gateway Address: The gateway IP address for the network segment to 
which the device is connected.  

z DNS Address 1~3:  
     Enter the DNS server IP address used for resolving domain names to IP   

     addresses and others are optional when necessary. 

z IP Setting Mode:  
           ☆ Static IP: Manually assigned IP address. 

           ☆ DHCP: Automatically get IP address from DHCP server. 

z HTTP Port: The port on which the device will receive HTTP requests. 

z RTSP Port: The port on which the device will receive RTSP (streaming video) 
requests. Static. 

z Apply: Saves the changes made. 
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– DDNS 

 

The DDNS (Dynamic Domain Name Service) is used when users want to access 
15-CD01NB with an easy memorized name such as “http://test.dyndns.org” 
instead of IP Address”.  

This service could be useful when 15-CD01NB is located behind Dial-up ADSL or 
IP sharing devices, which does not have fix IP address, then it's impossible to 
reach  15-CD01NB from Internet.  

� DDNS Settings: System provides two different kinds of settings for DDNS 
function and users can use both at same time. 

   
z DDNS Settings 1:  

    This is a public DDNS server that it provides DDNS service without registering   

    any information. 

           ☆ DDNS Settings 1: “Enable” or “Disable” the DDNS function. 

    ☆ Device Name: Enter the name of the device. I.E: If the device name is    

       “test” and the accessed DDNS server name is “dyndns.org”. 

              This device DDNS name is “test.dyndns.org”. 

           ☆ DDNS Server Address: Enter the DDNS server address or domain name. 

           ☆ DDNS Connect Port: Specify DDNS server listen port, and the default is    

              "80". 

     ☆ Router Incoming Port: Specify your router listen port for DDNS server to    

       redirect. The router may configure the different port for incoming (Internet    

       request) and outgoing (Intranet request), e.g. it may configure to redirect   
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       Internet HTTP (port 80) request to Intranet port 8000, then, in this case, we        

       must configure the "Router Incoming Port" to 80, and inside the  

       15-CD01NB Network settings should set HTTP port with 8000. 

     ☆ Update Time: Specify the 15-CD01NB updated frequency in seconds, and   

       the default is 600 (10 minutes), this is interval that 15-CD01NB will    

       automatically send an updated packet to DDNS server. 

            ☆ Apply: Saves the changes made. 

   

z DDNS Settings 2:  
     This is not a full public DDNS server that it provides DDNS service and must    

     register some information in the server. 

            ☆ DDNS Settings 2: “Enable” or “Disable” the DDNS function. 

            ☆ DDNS Host Name: Specific the DDNS server host name. 

            ☆ Account ID:  

               Specify your account ID that you registered in the DDNS server. 

            ☆ Password:  

               Specify your password that you registered in the DDNS server. 

            ☆ Apply: Saves the changes made. 

z DDNS Message:  
            Return messages from remote DDNS server, and some hints may help to      

            diagnostic the reason if register fails.. 

☆ DDNSaddr CGI Fail: It means that 15-CD01NB can't communicate 
with Internet world. Make sure your Network Configuration has 
correct subnet mask and default gateway, and DNS1 setting is 
correct and reachable. 
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☆ Already Registered: Another user had registered this name; please  

   change your register name by changing server name. 

5.3. System 
– System Information 

 

 

� MAC Address: This is the read-only information to Display the device's MAC 
address. 

� Language: Select the language to be used. English, Traditional and Simplified 
Chinese can be chosen. 

� Description: Useful as an administrative identifier.  

          It does not affect the operation of the device. 

� Location: Useful for identifying the position of the device.  

          It does not affect the operation of the device. 

� Model: Displays the model number for the device. 

� Firmware Version: Displays the firmware version to easily compare firmware 
version when user upgrade firmware. 

� Apply: Saves the changes made. 

� Load Default: If select this button, system would be reset to factory default, but 
not include ”Network Settings”. 
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– Time Configuration 
 

 

         
� Server Time Setting: The 15-CD01NB provide two kinds of time settings. 

z Server Time:  
            This is read-only information to display 15-CD01NB system time. 

z Time Mode:  
    ☆ Synchronize with NTP server: Auto synchronizes the time with NTP   

       server by the time zone and the NTP server 1~3 settings. 

           ☆ Set Manually: Manually enter the system date and time or synchronize  

              with computer time. 

z Apply: Saves the changes made.  
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– User 
 

    
Note: The first added user must have administrative right, and must be the last one 
to be removed. 

� To add a user, first enter the user name and password in the respective fields, 
and then click on “Add User”. 

� To remove a user, first select the user from the list, and then click “Delete User”. 

� User Name: The user name must be between 1 and 16 characters and cannot 
include the following characters: , : & 

� Password: The password must be between 1 and 16 characters and cannot 
include the following characters: , : & 

� Channel 1~4 Permission Settings: To set up the permissions for the general 
users which channels could be accessed. 

          These settings must have administrator permissions. 
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5.4. Event 
– General 

 

 
� Trigger: System provides “GPIN” and “Motion Detection” to trigger events. 

z GPIN & GPIO Input Status: They are auto detected to display the status. 

z Motion Detection: When Users would like to use “Motion Area” function and 
this icon must be enabled. 

� Action: Use some functions to record events. 

z FTP Image: When Users would like to use “FTP Setting” function and this  

  icon must be enabled. 

z Mail Image: When Users would like to use “E-Mail Setting” function and this 
icon must be enabled. 

z GPOUT:  It is auto detected to display the status. 

z Relay Out: Turn “Off” or “ON” for relay out setting. 

z Alert Message Status: They are auto detected to display the status with the 
recording application software. 

z Apply: Saves the changes made. 
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– Motion Area 
 

 

         

� Motion Area:  

          The “Motion Detection” icon (Configuration>Event>General>Trigger) must be  

   enabled when use this function. 

z Use Mouse to drag out a detection area on the video.  

z Left-click the area and drag the corner to change the size.  

z Right-click the area and select “Property”.  

z Check “Enable”, click “OK” and click “Apply”.  
         Note: Green blocks indicate this area is enabled for detection. 

        Red blocks indicate this area is not enabled for detection. 
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� Box Property:  

z Motion vector threshold (default value: 4000):  
    Motion vectors are typically used to compress video by storing the changes to    

    an image from one frame to the next. We use these vectors creatively to detect   

    and track motion and to find an alternative to traditional video decoding using  

    phase shifting. 

z SAD (Sum of Absolute Differences) threshold (default value:50):  
    SAD number value that the difference of movements of the image drew, will be  

    started and made video recording when there are differences in SAD number    

    value before and after comparing. 

z Sensitivity (default value:60):  
    This number value is the sensitivity of setting up Motion Detect Recording; the  

    higher number value will start Motion Detect Recording function. 
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– E-Mail / FTP 
 

 

� E-mail Setting:  

   The “E-Mail Image” icon (Configuration>Event>General>Active) must be    

   enabled when use this function. 

z Mail From: Enter the mail address of the mail sender.  

z Receipt To: Enter the mail address of the mail receiver.  

z Mail Server: Enter the mail server name or IP address.  

z Authorization: Disable or enable the security for mail authorization.  

z Account ID & Password: Enter the user name and password for the mail 
sender.  

� FTP Setting:  

   The “FTP Image” icon (Configuration>Event>General>Active) must be enabled      

   when use this function. 

z Host Name: Enter the IP address of the FTP server.  

z User Name & Password: Enter the user name and password for the FTP 
server.  

z Apply: Saves the changes made.  
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666...   BBBrrroooaaadddbbbaaannnddd   CCCooonnnnnneeeccctttiiiooonnnsss   QQQ&&&AAA   
– How can I configure my Video Server with my ADSL connection?  

  When using an ADSL connection you have to know if your ISP assigned you a     

  Static Public IP or Dynamic Public IP. Consult with your ISP for more information. 

– What is the difference between Static Public IP and Dynamic Public 
IP?   

  When using a Static Public IP, every time you get connected to the ISP, you will   

  be using the same IP; when using a Dynamic Public IP, every time you get  

  connected to your ISP, you will be using a different IP. 

– Can I plug my Video Server directly into the ADSL Modem?  
  No, the main reason is that presently, the Video Server doesn’t have the PPPoE     

  feature, even if you plugged it in, there must be a feature present that dials to the    

  ISP. 

      

– I only have an ADSL connection and don’t plan on getting a static 
Public IP. What can I do in order to make this work? 

  You can buy a Router which needs to have PPPoE and port forwarding    

  capabilities. In the market, mostly all routers come with these features and they   

  aren’t expensive. Please consult with your provider regarding this matter. Refer   

  to the next section for Port Forwarding settings. 
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– Once I set this up, how can I view my camera through a remote 
location? 

 You can register your camera or video server at our DDNS Service, and even if   

 your Public IP changes, you can access it from a remote location. Refer to Video   

 Server Manual at Network Configurations, DDNS settings in order to set it up. 

– How can I view my camera from a remote location through Internet 
when running the camera through my Local Network? 

  This will require some configuration on your broadband router. 

– Useful terms:  
� Broadband Router: 

   A broadband router allows users to share a single Internet connection. 

� TCP/IP:  

   TCP/IP is the protocol that computers use to communicate on the Internet. 

� TCP/IP Ports:  

   Each service you use on the Internet communicates using one or more specific    

   port numbers; your e-mail program uses port number 25 to send e-mail, and  

   port 110 to receive e-mail from your e-mail server. 

   When you browse the Internet, port number 80 is used as default to send and   

   receive Web pages. 

� IP Address:  

   Everything that is connected to a TCP/IP network needs a unique address, an   

   IP address. This is what happens when you browse the Internet with requests    

   to view Web pages.  

� Public IP Address: 

   A Public IP Address is the only IP address that is recognized on the Internet,   

   where the term Internet refers to the global network, the World Wide Web. 

� Local IP Address:  

   A local IP address can only be used internally, on a local network. A computer   

   with a local IP address cannot access the Internet itself. It can however, access  

   the Internet via another computing device, e.g. a broadband router. 

� Port Forwarding :  

   Port forwarding, is essentially a method for a broadband router to forward data   

   traffic aimed for one port on its public network interface to a computer or  

  network camera on the local network. Ports run from 0 to 65535. Note that ports  
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  0 to 1024 are well known ports, which means that those ports are already    

  assigned to specific services. So when you consider choosing your own ports,  

  select those starting from 1025 to 65535. 

– Configuration Examples:  
  You are a user with a network camera who wants to access it from a remote   

  location through the Internet. The following equipment is available: 

  E 1 Network Camera Sever. 

  E 1 PC running Windows. 

  E 1 Broadband Router. 

 

We need to direct all incoming requests that reach port 80 the public network 
interface of the broadband router, so that these are forwarded to the cameras IP 
address on the local network. Consult your broadband routers manual for 
information on how to configure port forwarding. Depending on the router, it could 
be denominated as Port Forwarding/NAT/Virtual Server. Usually it will look like this: 

 

Private IP Private Port Type Public Port 
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6.1. Case 1 Using default settings 

 

In this case what we have here is: 

� 1 Public IP Address 210.20.35.163, assigned by the Internet Service Provider 
(ISP). 

� 1 Camera Server, with a local IP of 192.168.1.21. 

� 1 Broadband router. 

Since we are sharing only one single Internet connection through our Local 
Network, the Port Forwarding configuration in our Broadband Router for the 
camera will be as follows: 

Private IP Private 
Port 

Type Public 
Port 

192.168.1.21 80  80 

Notice that the Port 80 is the default port for any Web-Server, but this also can be 
changed. Since Port 80 is the default, when we type our IP address at the Address 
bar, there won’t be any need to type the port number. 

Once the broadband routers configurations are set, we can open the Internet 
Explorer and type in the Address bar the Public IP address. 

 

� Can I use DHCP from my router to assign an IP to my camera? 

We don’t suggest it, if you do this, every time you reboot your camera, a new IP will 
be assigned and you will have to configure again your router in your Port 
Forwarding configuration. 
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6.2. Assigning ports manually 

 

In this case what we have here is: 

� 1 Public IP Address 210.20.35.163, assigned by the Internet Service Provider 
(ISP), but we will be using Port 9999 for accessing the camera from the 
Internet. 

� 1 Video Server, with a local IP of 192.168.1.21, using port 9999 to get access to 
the camera through the Local Network 

� 1 Broadband router 

Since we are sharing only one single Internet connection through our Local 
Network, the Port Forwarding configuration in our Broadband Router for the 
camera will be as follows: 

Private IP Private Port Type Public Port 

192.168.1.21 9999  9999 

In this case we are using Port 9999 for the camera server at 192.168.1.21, and 
using Port 9999 for the Internet access at 210.20.35.163. 

When we are in a remote location, in order to access our camera through Internet, 
we have to specify the Public Port when typing the Public IP Address as the figure 
below: 

 

Note that if changes are made to the port assignation, some configurations at the 
15-CD01NB also have to be changed, such as Network and DDNS settings. 
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6.3. Using 2 or more Public IPs 
The following figure is just an illustration on how the camera can be connected 
when 2 or more Public IPs are involved in a network infrastructure. 

 

In this case, the network configurations for the camera such as IP address, 
Gateway, DNS will be assigned by the ISP. 
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777...   TTTrrrooouuubbbllleeessshhhooooootttiiinnnggg   
� Symptom: 

The 15-CD01NB can not be accessed from a Web Browser. 

Possible Causes Remedial Actions 

The IP address is already used by 
another device. 

Disconnect your 15-CD01NB from the 
network. 

Run the PING utility and follow the 
appropriate recommendations.  

Note: The assigned IP number can be 
assumed valid if the PING utility returns 
"request timed out" - in which case you 
should set the IP address again, power 
on the 15-CD01NB and then try 
accessing the unit again. 

The IP address is located within a 
different subnet. 

Run the PING utility, If the utility returns 
"no response" or similar, the diagnosis is 
probably correct. Then, you should 
proceed as follows: In Windows 95/98 or 
Windows NT, check that the IP address 
for your 15-CD01NB is within the same 
subnet as your workstation:  

Click "Start", "Settings", "Control Panel" 
and "Network".  

Specify the TCP/IP adapter and click on 
Properties. Then, click "IP Address" in 
Properties. 

Check that the first 3 numbers within the 
IP address of your 15-CD01NB matches 
the first 3 ones of your workstation. If not, 
your 15-CD01NB may be on a different 
subnet and the IP address cannot be set 
from this workstation. You must set the IP 
address for the 15-CD01NB from a 
workstation on the same subnet. 
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In Windows 95/98, the ARP table was 
empty when you tried to set the IP 
address. 

In Windows 95/98, the ARP command 
can't be used if your have an empty ARP 
table. Type arp Va to view the ARP table. 
If it is empty, you must ping an existing 
unit on your network before you can 
download the IP address to the 
15-CD01NB. 

A programming script locks the unit. Restore the unit to the factory default 
settings. 
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888...   RRReeessstttooorrreee   FFFaaaccctttooorrryyy   DDDeeefffaaauuulllttt   
To restore the factory default for 15-CD01NB, please follow the steps: 
  
1. Plug out the power jack to turn off the 15-CD01NB. 
2. Notice at the Power LED, when power on the LED is red, wait for few seconds, the 

LED becomes to orange, wait for the orange LED flash four times, it will back to 
red, at the moment, release the button in the hole and the 15-CD01NB will be 
restored to factory defaults. 
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999...   III///OOO   &&&   CCCOOOMMM   PPPooorrrttt   CCCooonnnnnneeeccctttooorrrsss   
  The GPIO & COM provides control signal input and output, which including one GPIO   

  input, GPIO output as Relay connection and one RS-485 port multiplex with COM port.  

  The GPIO & COM port provide connection of PTZ devices and external console to   

  control the device. 

– See following picture indicate the Pin direction:  

 

COM / GPIO MINI-DIN 

PIN NAME 

1 GPIN 

2 RXD (Receive Data) 

3 TXD (Transmit Data) 

4 RS-485A 

5 GND (System Ground) 

6 GPOUT-Automatic Relay 

7 GPOUT-Automatic Relay 

8 RS-485B 

9 Video Out 
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� GPIN:  

   Input high when opening the connection; input low when sinking more than   

   10mA or shorting to pin 5 (GND). 

� RXD (COM Port Receive Data)  

� TXD (COM Port Transmit Data) 

� RS485A / RS485B:  

   To connect with external PTZ devices, please contact your dealer/distributor to   

   get the information of the supported PTZ models.  

� GND (System Ground): 

   System Ground is also connected to chassis as frame ground. 

� GPOUT-Automatic Relay:  

    
   When enable to use the GPIN or motion detection to trigger some alarm   

   devices, the “Relay Out” must be turned on.  

� Video Out:  

   Use the especial cable in the product package to connect this pin that it can    

   output the video to the monitor.     
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– Specifications of the Solid state Relay: 
� Features:  

z Normally Open, Single Pole Single Throw  

z Control 350VAC or DC Voltage  

z Switch 130mA Loads  

z LED control Current, 5mA  

z Low ON-Resistance  

z dv/dt, >500 V/ms  

z IsolationTest Voltage, 3750VACrms Ω  
 

� Absolute Maximum Ratings: (TA=25℃) 

Emitter (Input) Detector (Output) 

Reverse Voltage: 5.0V Output Breakdown Voltage: ±350V

Continuous Forward Current: 50mA Continuous Load Current: ±130mA

Peak Forward Current: 1A Power Dissipation: 500mW 

Power Dissipation: 100mW  

Derate Linearly from 25℃: 1.3mW/℃  

General Characteristics 

Isolation Test Voltage: 3750VACrms Storage Temperature Range: 

-40℃ to +125℃ 

Operating Temperature Range: 

-30℃ to +85℃ 

Isolation Resistance: 

Vio=500V, TA=25℃, ≧1010Ω 

Junction Temperature: 100℃  

Total Power Dissipation: 550mW 

Derate Linearly from 25℃: 2.5mW/℃

Soldering Temperature, 

2mm from case,10 sec: 260℃ 
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111000...   SSSpppeeeccciiifffiiicccaaatttiiiooonnnsss   
 

Hardware 
System  
CPU: 32-Bit RISC Processor 
ROM: 4MB Flash ROM 
RAM 32MB SDRAM 
Watchdog: Chip to monitor system voltage tolerance and abnormal program execution 
Connectors  
One RJ-45 connector for Ethernet 
One mini-DIN for RS-485/RS-232/GPIO/Video out 
-- RS-485: for external Pan/Tilt (PT) device control 
-- RS-232: for console connection 
-- GPIO: for one fully opto-isolated alarm input 
-- Video out: for connecting to CCTV monitors, DVR, etc. 
One BNC video input, and one BNC loopback video output 
Two LEDs to indicate network and power/system status 

Network 
Network Interface  
10/100 Base-T Ethernet 
Resolutions 
Full D1 (4SIF): NTSC = 720x480; PAL = 720x576 
SIF: NTSC = 352x240; PAL = 352x288 
QSIF: NTSC = 176x112; PAL = 176x144 
Video Bitrate 
16K ~ 4M bits/sec (CBR/VBR configurable (high quality VBR settings for MJPEG can 
reach up to 10Mbps) 
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Management 

Installation  
IP Installer (Win32 Application) 
Client PC Requirements  
Pentium 4 2.0GHz or equivalent 
512MB RAM 
Microsoft Windows 98se/Me/2000/XP 
Microsoft Internet Explorer 5.x or above 
Microsoft DirectX 9.0c 
Macromedia Flash 6 
Xvid MPEG-4 Codec 
Security  
Multi-tiered access control for configuration 
Recording 
Directly from Web UI while viewing the live video stream 
Ware Recording Software – free 16-channel surveillance and configuration software 

Operating Environment 
Operating Temperature  
5°C ~50°C (40°F ~ 125°F) 
Operating Humidity 
20%~80% RHG 
Power Consumption  
 < 8 watts     (Fuse: 250V / 2A) 

Mechanical Design 
Dimension  
239(L) X 179(W) X 55(H) mm 
Net Weight  
1.44 KGS (excluding power adapter) 
Approvals  
CE/ FCC 

      


